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Abstract: The developed software ASNA-2, which is 

an improved version of the software ASNA-1, is based 
on the technology of automated estimation of reliability 
indexes of fault-tolerant systems. This software is 
designed for automated evaluation of the reliability 
indexes of fault-tolerant hardware – software systems. 
This paper describes a software ASNA-2 with the 
peculiarities of procedures of  reliability analysis of 
fault-tolerant systems. 
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1. Introduction  
The complexity of modern engineering systems 

causes a large dimension of mathematical models of 
reliability (hundreds of thousands) that makes it 
practically impossible for them to be formed and 
analysed manually. Therefore, apart from the 
requirement of high reliability of the models, there is 
another requirement of the appropriate level of 
formalization which enables the automation of their 
development and analyzing the reliability using modern 
computer facilities. The combination of analytical 
research methods of reliability with the computing 
capability of modern computers is a perspective 
direction of the further development of methods for the 
analysis of complex systems reliability. Among the 
analytical methods, most widely used methods are those 
based on the theory of Markov discrete-continuous 
processes which consider random events (failures and 
recovery of system elements), which follow one after 
another in a certain sequence as stream of random events 
and thus describe the trajectory  (state-to-state transition) 
of a complex technical system. These methods allow you 
to determine the reliability of systems with different 
types of redundancy and recovery which provide the 
system with a fault tolerance feature. 

A mathematical model (MM) of the reliability of a 
technical system, which describes in time the process of 
transition of  the system from one state to another, is a 
system of the Chapman-Kolmogorov differential 
equations, whose solutions describe  time dependences 
of the probabilities of being the technical system in all 
possible states, and, thus, allow to determine necessary 

reliability indexes (probability of failure-free operation, 
function and coefficient of availability, MTTF, mean time 
between failures, mean recovery time, etc.). The construction 
of the mentioned MM implies the formation of a graph of 
states and transitions for the object under research. This 
problem is complicated because for real fault-tolerant 
systems, the number of states exceeds hundreds and the 
number of transitions – thousands [1 – 3].  

In [1], the Markov models development 
technology, which enables the process of forming a graph 
of states and transitions to be automated, is proposed. This 
technology foresees the use of formalized representation of 
the object of study in the form of structural-automatic 
model (SAM). On the basis on this technology, structure 
of a tool for the automated assessment of reliability indixes 
of fault-tolerant systems has been developed, and on the 
same basis as well as the software ASNA-2, which is an 
improved version of the software ASNA-1 [10], [11, pages 
109-121] and is designed for automated assessment of the 
reliability of fault-tolerant hardware and software 
radioelectronic systems.  

This article describes the structure and specificity of 
the software ASNA-2 realizations taking into account 
the peculiarities of the procedures of reliability analysis 
of fault-tolerant systems. 

2. Software structure 
The software ASNA-2 has advanced features which 

include: 
 Selection of an algorithm for the formation of 

matrix of the Chapman-Kolmogorov diferential 
equation coefficients. 

 Introduction of random initial conditions. 
 Selection of a numerical method for solving the 

systems of differential equations. 
 Processing the results obtained due to solving the 

systems of differential equations. 
 Entering start and end points of integration as 

well as the number of integration steps. 
 Viewing the matrix of coefficients of the systems 

of differential equations 
 Exporting final and intermediate results in MS 

Excel format. 
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In order to ensure these functional capabilities, there 
have been made the following developments: 

 a software unit that implements the input of initial 
conditions for the solution of the Chapman-
Kolmogorov differential equations. 

 a software unit that implements connection of 
modules with the implemented methods for solving 
the Chapman-Kolmogorov differential equations in 
the form of DLL (Dynamic Link Library – library of 
dynamic layout). 

 units in which 4 methods of numerical solution of the 
Chapman-Kolmogorov differential equations were 
implemented. 

 a software unit and an interface that handle the 
solutions to the Chapman-Kolmogorov differential 
equations. 

 a unit which exports the output data (out). 
A generalized structure of the software considering the 

requirements [4, 5] is shown in Fig 1.  
The input data is a structural automatic model which 

includes a set of formal parameters, components of the state 
vector and their initial values and a tree of modification rules 
of state vector components. Based on these data, there are 
formed a model as a matrix of coefficients of the system of 
the Chapman- Kolmogorov differential equations (SDE), and 
a list of all states and transitions of the research object. 

The next step is solving the existing SDE. The given 
program implements four algorithms for solving the existing 
SDE in the form of dynamically loading libraries (DLL) and 
a unit that is responsible for their connection. Реалізований 
модуль визначає правила створення функцій розв’язання 
СДР, які потрібно враховувати при створенні нових 
бібліотек з алгоритмами їх розв’язку при подальшому 
удосконаленні програмного засобу ASNA-2.  

The implemented unit establishes the rules for creating 
functions of a SDE solution that you should consider when 
compiling new libraries with the algorithms of their solution 
in the process of improvement of  the software ASNA-2. 

Another element of the software is a unit for processing 
SDE solutions, which can be carried out by three methods. 

The results having been processed, and the necessary 
efficiency indexes having been obtained, exportability of all 
the results obtained, using the software was realized. 

The main unit in the software ASNA-2 is the unit 
UnitMain, to (in) which Interface and Implementation units 
are connected. The Interface unit in turn contains: 

 • Common is a unit, which describes the procedures 
and functions for input data processing (structure-
automatic model and constants) and calculation of the 
matrix of the Chapman-Kolmogorov  SDE coeffi-
cients, using the method of complete enumeration. 

 uCalcul is a unit which describes various procedures 
and functions of processing string-type variables and 
other types of variables. 

 The Implementation unit contains: 
 UnitProgress is a unit which describes the form 

whose components can display of program execution. 
 UnitAbout is a unit which describes the form of 

FormAbout. 
 UnitExport is a unit which implements the export of 

calculation results, namely a matrix of the SDE 
coefficients, a list of state vectors, solutions to SDE in 
a file with txt or xls extension, and solutions to SDR 
as an image file. 

 FOM is a unit which describes the form of choosing a 
calculation algorithm for the matrix of the Chapman-
Kolmogorov SDE coefficients (a complete enumera-
tion algorithm, and a Treelike algorithm). 

 Matrix implements a form on which the matrix of the 
Chapman-Kolmogorov SDE coefficients is displayed. 

 UnitP79 is a unit in which a Treelike algorithm for 
finding the matrix of the Chapman-Kolmogorov SDE 
coefficients is implemented. 

 PidklDLLInterface is a unit that is responsible for 
downloading of a selected dynamically connecting 
library in which the algorithm of solving the 
Chapman- Kolmogorov SDE is implemented. 

 VibMeth is a unit that is responsible for selecting a 
dynamically connecting library in which the 
algorithm of solving the Chapman-Kolmogorov SDE 
is implemented.  

 PochUmov is a unit in which the form for introducing 
initial conditions of the Chapman- Kolmogorov SDE 
is described. 

 Exeption is a unit in which a shape which implements 
the input of the maximum number of steps, and the 
coefficient of multiplying the number of steps which 
eliminates a situation that could occur during the 
execution of the program due to the insufficient 
number of steps is described 

3. Features of the software ASNA-2 implementation  
The software is implemented according to the structure 

(Fig. 1) as a single exe-unit that is Analyze1.exe and dll-units 
of the dynamically loading libraries located in the folder SRC 
Interface, each of which corresponds to a particular method 
of solving the Chapman-Kolmogorov SDE, namely: 
BG_DLL.dll is implemented on the basis of the Runge – 
Kutta – Merson algorithm, R_KDLLInt.dll is implemented 
on the basis of the Runge – Kutta, DLLInt algorithm adapt.dll 
is implemented on the basis of the Runge- Kutta algorithm 
with  an   adaptive  step,   R_K_Adams.dll  is   implemented  
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on the basis of the Runge – Kutta – Adams algorithm. 
Besides, this software includes the file manual.txt, which 
contains a help file and a user manual. 

A complete cycle of testing separate units and 
testing the software as a whole according to [6-9] is 
carried out. From the obtained results of testing the 
software units, one can conclud that the developed 
algorithms for the solution of systems of differential 
equations work correctly, and dynamically loading 
libraries were properly implemented and tested to a 
sufficient extent. 

Features of the user interface. The user interface is 
implemented as a set of tabs divided into two parts – for 

data input, and analysis results output. Switching 
between these modes is performed by the buttons Input 
and Output (Fig. 2). Entering the sets of formal 
parameters of the object under research is carried out in 
the tab Constants and Info. Entering the components of a 
state vector, their initial values and conditions of critical 
failure is carried out in the tab Vectors and Refuse 
expression. Entering the tree of modification rules is 
carried out in the tab Event tree. Each tab contains 
buttons for adding a new record (Add), inserts of 
additional record (Insert), modification of an existing 
record (Replace), delete of the existing records (Delete) 
and cleaning the current data (Clear). 

 

Fig. 2. Interface of data input (structural-automatic models of a target object). 

 
Selection of initial conditions 
To enter initial values of probabilities of being in of 

the target object’s states at time t = 0, a special form is 
developed: Options → Initial conditions. In the left hand 
column,  the number of the state is entered, and in the 
right hand one, the same is done with the initial value of 
the probability of being in the state at time t = 0 (Fig. 3). 

Choice of a method to solve the Chapman-
Kolmogorov SDE   

To choose a method for solving the Chapman-
Kolmogorov SDE, one needs to select an appropriate 
dynamically loading library – DLL-file. ASNA-2 
implementes such methods of the solution to the 
Chapman-Kolmogorov SDE as: 

 Method of Runge – Kutta with a fixed step 
 Method of Runge – Kutta with an adaptive step 

 Method of Runge – Kutta – Mersona 
 Method of Runge – Kutta – Adams 
The form for choosing a method appears as a result 

of pressing Options → Choice of method (Fig. 4). 
Choice of a method for the formation of a 
coefficient matrix which corresponds to the 
Chapman- Kolmogorov SDE 
Unlike ASNA-1, the software ASNA-2 implementes  

two different methods of forming the coefficient matrix that 
correspond to the Chapman- Kolmogorov system SDE, 
namely: the method of defining states through the sequential 
view of all situations, and then through the determination of 
PKMVS and the optimized method based on treelike 
representation. The form for the selection of a method of 
forming a coefficient matrix appears as a result of pressing 
Options → Forming of Matrix (Fig. 5). 
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The ASNA method is a complete enumeration 
algorithm, which was implemented in ASNA-1. 

Page79 Method is a Treelike algorithm described 
in [1]. 
 

A coefficient matrix formed in accordance with 
the chosen method  can be seen in the tab "Vectors and 
Matrixes", or by selecting View → Matrix of 
coefficients (Fig. 6) 

 

Fig. 3. Entering the initial conditions. 
 

 

Fig.4. Choice of a method for solving  
differential equations. 

 

Fig. 5. Choice of a method for forming   
a coefficient matrix. 

The results of calculating the reliability indexes of 
fault-tolerant hardware-software 

The results of calculating the reliability indexes of 
fault-tolerant hardware-software radioelectronic systems 
can be obtained by switching to the mode of data output, 
using the button Output. There are three tabs available in 
this mode: Debug is used for debugging the model, 
Vectors and Matrix is designed for processing the 
modeling results (solutions to the Chapman-Kolmogorov 
SDE), and Graph is to output the results of the solution 
to the Chapman-Kolmogorov SDE. Handling the 
solutions to the Chapman-Kolmogorov SDE consists in 
summing up the solutions selected by a user (Fig. 7). The 
choice can be of three types, as shown in the panel: 

Total (Total) – summarizes the values of all the 
solutions that are found in the range from 1 to N and 
correspond the argument tk, for example, P1 (tk)…PN (tk). 

Total, except for (total, except for) – summarizes 
the values of all the solutions that correspond to the 
argument tk, except the selected functions, for example, 
P5 (tk), P25 (tk), PN (tk). 

Set (set) – summarizes the values only of the specified 
solutions P1 (tk)…PN (tk) which correspond to the argument 
tk, for example, P5 (tk) + P25 (tk) + PN (tk). 
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Fig. 6. Matrix of coefficients. 

 
  

 

Fig. 7. Handling the solutions to differential equations. 
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Fig. 8. Results of processing the solutions to SDE in the form of dependencies of probabilities  
of failure-free operation on the duration of operation time. 

Fig. 9. Results of processing the solutions to differential equations. 
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The solutions to the Chapman-Kolmogorov SDE, 
and the results of processing the solutions are on tab 
Output → Graph → Graph and Series (Fig. 8, Fig.9) 

Export of results 
In order to process the results of automated 

assessment of the reliability of fault-tolerant hardware-
software radioelectronic systems at different stages of 
modeling by means of MathCAD, MatLab, Excel, etc., 
the program ASNA-2 is capable to export the modeling 
results into various formats – text, dat files, and files of 
xls format – MS Excel format, and in an image format. 

The export of the results is implemented as follows: 
Output → Export ... (Fig. 10) 

 

Fig. 10.  Export of results. 

Implementation of the software ASNA-2 suggests that it 
is possible to connect the new dynamically loading libraries 
(DLL) which are responsible for the solution of SDE and are 
created by third-party developers. 

4. Conclusions 
1. Functionalities of the software ASNA-2 allow 

developers to effectively carry out the comparative analysis 
of alternative fault-tolerant systems that differ among 
themselves multiplicity and methods of redundancy, recovery 
strategies, etc., and on this basis to choose the best options. 

2. For the effective use of the software ASNA-2 a user 
must master the technique of developing structural-
automaton models, which are formalized by a description of 
the modeling object that requires some investment of time, 
which thus fully justify themselves at carrying out a 
multivariate comparative analysis. 

3. Experience of using the software ASNA-2 for solving 
the problem of reliability analysis of radioelectronic systems, 
the number of states of which reaches hundreds, and the 
number of possible transitions between states reaches 
thousands, has shown that it takes only a few minutes to 
determine the reliability of the systems. 
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РОЗШИРЕННЯ МОЖЛИВОСТЕЙ 
ПРОГРАМНОГО ЗАБЕЗПЕЧЕННЯ ДЛЯ 

НАДІЙНІСНОГО АНАЛІЗУ  
ВІДМОВОСТІЙКИХ СИСТЕМ  

Богдан Волочій, Богдан Мандзій,  
Леонід Озірковський 

У статті представлено нові можливості спеціалі-
зованого програмного забезпечення ASNA-2, яке 
призначене для автоматизованої оцінки показників 
надійності відмовостійких програмно-апаратних систем. 
Розроблене ПЗ засноване на оригінальній технології 
автоматизованої оцінки показників надійності від-
мовостійких систем, розробленої авторами.  

 
Bohdan Volochiy – Ph.D., D.Sc., 

Professor of Theoretical Radio 
Engineering and Radio Measuring 
Department at Lviv Polytechnic National 
University, Ukraine. His teaching 
experience in institutions of higher 
education makes up over 35 years. He is 
the author of 160 publications, including 
2 monographs, 3 textbooks, 4 inventions.  

He has supervised 3 Ph.D theses. Research interests: 
theory and practice of system-design of radioelectronic 
information systems. 

120

Lviv Polytechnic National University Institutional Repository http://ena.lp.edu.ua



Extending the Features of Software for Reliability Analysis of Fault-Tolerant Systems 

 

Bohdan Mandziy – Ph.D., D.Sc., Pro-
fessor of the Department of Theoretical 
Radio-Engineering and Radio-Measuring, 
Lviv Polytechnic National University, 
Ukraine. His research and teaching 
experience makes up over 40 years. He is 
the author of over 250 scientific papers and 
2 monographs. He has supervised 9 PhD 
theses and 3 dissertation of Doctors of 

Technical Sciences. The research area: analysis of non-linear 
electronic circuits and methods of reliability control of radio 
electronic devices and communication equipment. 

 

Leonid Ozirkovskyi – Ph.D., 
Associate Professor of Theoretical Radio 
Engineering and Radio Measuring 
Department at Lviv Polytechnic 
National University, Ukraine. His 
teaching experience in institutions of 
higher education makes up over 10 
years. He is the author of 65 scientific 
publications and 22 teaching aids, 

including 4 textbooks. The research interests include 
development of methods and tools for modeling functional 
behavior and reliability of information systems. 

 
  

 

121

Lviv Polytechnic National University Institutional Repository http://ena.lp.edu.ua


